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What is Ascend

Ascend is a computer software program designed specifically to be used with the Franklin Day 
Planner.    Although anyone can increase their personal productivity with Ascend, its real strength 
comes from using it in the manner taught by Franklin International Institute, Inc.    All reports and 
forms printed with Ascend are designed to be printed on pages from a Franklin Day Planner.

For more information about Franklin International Institute, Inc. Contact:

Franklin International Institute, Inc.
2640 Decker Lake Blvd.
Salt Lake City, UT    84119
801-975-1776
1-800-654-1775



Performance Considerations

In order for Ascend to work at its optimum, you must have sufficient hardware and your hardware 
must be configured properly.    Chapter 13 of your Windows User's Guide discusses how you 
can optimize the performance of Windows and Ascend.    It is highly recommended that you 
spend some time and read this chapter.    Some of the items that can affect the speed of 
Windows that are:

* Amount of memory (RAM) you have on your computer.

* Type of computer and speed of its microprocessor.

* Disk caching installed for your hard drive.

* Type, speed, and condition of your hard drive.



Who Can You Call for Help

If, after you refer to the on-line help and the User's Guides, you cannot find an answer to a 
question or problem that you are having, you can call Ascend's Technical Support Help line.    If 
your question is concerning Windows, you should call Microsoft's Help line.

Microsoft's Technical Support: 206-454-2030
Ascend's Technical Support: 801-476-9262

So that both Microsoft's and Ascend's technicians can answer your questions as quickly as 
possible, it is a good idea to have some information ready before you call.    The very last page of 
your Windows 3.0 User's Guide is an outline of information that you should know before calling 
either of these lines.    To help us answer your questions as quickly as possible, please review this 
outline before calling.



Registering Ascend

It is very important that you register your copy of Ascend!    Once installed, Ascend will only 
work for 60 days before requiring a special "Key Number."    This Key Number will be mailed 
to you from SIS after they receive your Ascend Registration Card.

To register your copy of Ascend, perform the following steps:

1. After Ascend has been started, select the Tools and Utilities icon (a hammer) by double 
clicking on the icon.

2. Select the Registration menu option along the top of the screen.    This will pull down the 
Registration Dialog Box.

3. Fill in the information in the Dialog Box.    You will not be able to fill in the KEY 
NUMBER field at this time.    After you have entered your registration name and serial 
number, you will see a User ID Number.    Take you registration card and fill in the 
information EXACTLY as it appears on the registration dialog box.

4. Mail in your registration card.

5. When you receive your Key Number, go back to the registration dialog box and enter in 
the Key Number.

Once you have entered in a valid registration key number, your copy of Ascend will work 
indefinitely.



Changing Ascends "Current" Window

You may have several windows and/or icons on your screen at one time, but only one of the 
windows can be the "current" or "active" window.    You can recognize the current window in 
several ways: 

 the color of the current window's title bar will be different from the inactive windows.

the control-menu box, maximize box, and minimize box of the inactive windows will not 
be displayed in the title bar.

the active window will never have another window "in front" of it.

To change the "current" window:

Mouse Users

To activate a particular window simply click your mouse anywhere on the window that you wish to 
activate.    If the window is minimized, double click your mouse on the window's icon and the 
window will be restored and activated.

Keyboard Users

There are three ways to select the current with from the keyboard:

1. Press the [Alt]+[W] and then press a number from 1 to 9 that corresponds with the 
window that you wish to make the active window.    Since Ascend has more than 9 
windows, if the window that you need is not listed, press [M] instead of a number from 1 
to 9, and a list of all the possible windows within Ascend will be displayed in a scroll list.    
Use your up and down arrows to find the desired window from the scroll list and then 
press [Enter].

2. You may press the [Shift]+[F1] key to make the Prioritized Daily Task List the active 
window, [Shift]+[F2] for Appointment Schedule, etc. through [Shift]+[F9].    The order of 
the windows represented by [Shift]+[F1] through [Shift]+[F9] is the same as that displayed 
in the Windows menu described in option #1 above.    [Shfit]+[F10] will bring up the scroll 
list of all Ascend Windows.

3. You may "thumb through" all of the windows and icons by pressing [Ctrl]+[F6].    Pressing 
the [F6] function key while holding down the [Ctrl] key will rotate through all the windows 
and icons, highlighting each one.    When you are at the desired icon or window, simply let 
go of the [Ctrl] key.    (If the window you select is still in its icon form, you will need to 
expand it into a window by pressing [Alt]+[-] and then [R].)



Common Ascend Menus

Each of Ascend modules has it's own unique menu.    There are, however, a few menu options 
that are the same for each of the windows.

Options Menu
Window Menu



Options Menu

When you select the Options Menu, a pulldown menu will appear with the following options:

Save Window Setup
Printer Setup
Preferences
Speed Dial
Control Panel
File Manager
Print Manager
Calculator
System Editor
Windows Setup
Exit



Save Window Setup

Selecting this menu option will cause Ascend to save your current window positions and colors.    
This allows you to save any changes you have made to the size, screen position and color of a 
window.



Printer Setup

This option allows you to specify what type of printer you will be using, the font style, and point 
size.    When you first run Ascend, you should go into this option and enter the necessary 
information.

Select Printer Select the printer that you will be using to print out your tasks, 
appointments, etc.    All of the printers that you have installed under 
windows will be displayed here.

Font Once you have selected the appropriate printer, a list of fonts supported 
by that printer will appear.    Select the desired font that you want Ascend 
to use when printing.

Size Once you have selected the appropriate font that you want to print with, 
select the point size of the font that you desire.    Some fonts will only 
have one point size, while others will have several point sizes.    
IMPORTANT:    If you select too large of a point size, you will not get as 
much information on the printed page.    A point size of 6 to 10 is 
recommended.

Select the OK button when you have selected the necessary information.



Preferences

The Preferences sub-menu is where you customize Ascend by telling it your "preferences".

Capitalize Task

Select this option if you like all task and notes to always be in capital letters.

Printer Adjustments

You can "fine tune" the top and left margin of your printer by increasing or decreasing these field, 
thus making Ascend print as closely as possible within the lines of your Franklin Day Planner.

# of Times to Forward A, B, & C Task Priorities

When Ascend "forwards" a task, it can also forward that task's priority (A,B,C, or D).    Ascend 
keeps track of how may times a task has been forwarded, and this field allows you to tell Ascend 
not to forward a task's priority after the task has been forwarded X number of times.

# of Times to Forward D Task Priorities

This option is the same as # of Times to Forward A, B, and C Task Priorities but this option 
works on your "D" tasks which are usually tasks that you need to perform at home or in the 
evening.

# of Times Forwarded Before Master Task List Prompt

Allows you to tell Ascend to "prompt" you to move a task into the Master Task List after you have 
forwarded a task X number of times.

Default Print Task Notes on Notes Page

Ascend allows you to enter and save notes on each task.    When you add a note to a task, 
Ascend will allow you to specify whether or not you wish to have the note printed on your Daily 
Record of Events.    Every time you add a new task note you will be allowed to include it on the 
Daily Record of Events if you wish.    This preference item allows you to tell Ascend that you 
usually will or will not want to include a task's notes on your Daily Record of Events.

Default Include Notes in Monthly Index

This option is very similar to the Default Print task Notes on Notes Page discussed above, but 
deals with including appointment and task notes on your monthly index.

Default Include Journal on Notes Page

When you select the menu option to print your Daily Record of Events, you will be given the 
option of having your Journal entries printed as well.    If you usually include your Journal entries 
on your Daily Record of Events, you should select this option.

Planner Size

Select the size of the Franklin Day Planner you are using.

Minutes Between Auto Save



Ascend saves your files whenever you quit Ascend or switch to another Windows program.    As 
safety precaution to protect you against power failure, computer problems, etc., the program will 
save changes every X minutes.

Break Definition

Ascend uses a "break line" to separate items printed on your Daily Record of Events.    Click your 
mouse on the down arrow located next to the Break Definition box and select the type of break 
line you would like to use.

Break After Date

When you insert the System Date into a note, this option specifies whether to insert a break 
character after the date.

Break After Time

When you insert the System Time into a note, this option specifies whether to insert a break 
character after the time.

Break Between Notes

Print a break line between each note on your Daily Record of Events.

Display Evaluation

Select this option to display your evaluation in achieving your goals and values.

Master Task List

Enter the names of the five categories you desire to use in your Master Task List.

More Options

To access the second page of preferences, select the More Options box.



More Options

Quote of the Day

If you would like to randomly select one of the quotes from your Favorite Quotes file and display it 
when you start the program, select this option.

Positive Affirmations

If you would like to randomly select one of your positive affirmations from your productivity 
pyramid and display it when you start the program, select this option.

Default Phone Descriptions

Enter the descriptions of the five phone numbers for your Address and Phone file.

Password

If desired, you can enter a password in this field.    If a password is entered, you will be required to 
enter the password every time you start the program.



Window Color

This option allows you to change the background color of the current window by mixing different 
levels of red, green, and blue.    As you slide the scroll bar slider, you will see the color change in 
the rectangle box below.    Once you have the desired color in the rectangle box, select OK and 
this color will be applied to the currently active window.



Speed Dial

Allows you to use a modem to "auto dial" phone numbers from your Address and Phone file.

Each of the names in your phone and address section that have been marked as a "Speed Dial" 
number will be listed here.    Select the speed dial entry that you wish to dial and press the OK 
button.



Control Panel

This option allows you to run the Microsoft Windows' Control Panel directly from within Ascend.    
See your Windows User's Guide    for Details on the Control Panel.



File Manager

This option allows you to run the Microsoft Windows' File Manager directly from within Ascend.    
See your Windows User's Guide for Details on the File Manager.



Print Manager

This option allows you to run the Microsoft Windows' Print Manager directly from within Ascend.    
See your Windows User's Guide for details on the Print Manager.



Calculator

This option allows you to run the Microsoft Windows' Calculator program directly from within 
Ascend.    See your Windows User's Guide for details on the Calculator program.



System Editor

This option allows you to run the Microsoft Windows' System Editor program directly from within 
Ascend.    See your Windows User's Guide for details on the System Editor program.



Windows Setup

This option allows you to run the Microsoft Windows' Setup program directly from within Ascend. 
See your Windows User's Guide for details on running the Setup program.



Exit

When you select this option, Ascend will close down and remove itself from Windows.



Windows Menu

The Window menu is the second common menu throughout all Ascend modules.      When you 
select this menu option, you will be given the following options:

Arrange Icons
Options 1 - 9
More Windows



Arrange Icons

Selecting this option will automatically and evenly arrange any icons along the bottom of your 
screen.



Options 1 through 9

These options allow you to quickly go to any of the first 9 of Ascend's modules with the keyboard. 
For example, pressing [1] from the Windows menu will make Prioritized Daily Task List the current 
window.    These options can also be selected by pressing the [Shift]+[F1] through [Shift]+[F9] 
anywhere in Ascend.



More Windows

This option displays a scroll list allowing you to quickly go to any of Ascend's modules.    This 
scroll list can also be accessed by pressing [Shift]+[F10] anywhere in Ascend.



Common Keys Used in Ascend

F1 On-line Help
F2 Speed Dial Feature
F4 Goto Date Monthly Calendar (certain modules only)
Shift + F1 Prioritized Daily Task List
Shift + F2 Appointment Schedule
Shift + F3 Daily Record of Events
Shift + F4 Address and Phone
Shift + F5 Values and Goals
Shift + F6 Red Tabs
Shift + F7 Master Task List
Shift + F8 Focus
Shift + F10 Ascend Module Selection Scroll Bar
Ctrl + Esc Windows Program Selection Scroll Bar
Ctrl + F6 Rotate through Ascend Modules
Alt + Tab Rotate through Windows Programs (fast)
Alt + Esc Rotate through Windows Programs (slow)
Ctrl + F4 Close an Ascend Module Window
Alt + F4 Close and Exit Ascend (if in Ascend)
Alt + F4 Close and Exit Windows (if in Program Manager)
Ctrl+Insert Copy highlighted items into Windows clipboard
Shift+Insert Past items from Windows clipboard



Printer Considerations

Ascend was designed specifically to be used with the Franklin Day Planner.    It is important to 
understand that printing presses cannot print each page of the planner exactly the same.    As 
you begin using Ascend to print    on your Franklin forms, you will notice that it may move outside 
of the preprinted lines slightly on occasion.    This is due in part to the variation in lines and 
margins on the Franklin forms and also in part to how you line your paper up in your printer.

You can use the Printer Adjustments box in the Preferences section of Ascend to fine tune your 
printouts as much as possible, but the printouts will not always be exact.    This is usually not a big 
problem, but you should be aware of the situation.



Prioritized Daily Task List

The Prioritized Daily Task List is one of the main functions of Ascend and lets you prioritized your 
Daily Tasks using a simple "step-through" approach.    Tasks can be quickly forwarded to future 
dates via a pop-up calendar.    Notes can be kept on each task.    When a task is forwarded, the 
notes for the task are forwarded as well.    Tasks are printed in their prioritized order right on your 
Franklin Day Planner pages.    If desired, print notes for your tasks on your Daily Record of 
Events. 

You can enter recurring tasks to help you remember to purchase birthday presents, prepare for 
recurring meetings, etc.    You can also track your time by categorizing how much time you spend 
on certain tasks and displaying the information on a graph.

See Also:

Date Status Bar
Changing Dates
Entering Tasks
Adding Notes to a Task
Prioritizing Your Task List
Inserting a Task
Deleting a Task
Copying a Task
Moving a Task
Group Action
Forwarding with the Goto Calendar
Recurring Task
Repeat Tasks
Finding a Specific Task
Statistics
Sort Tasks
Start Timer
Printing Your Task List
Printing Monthly Index



Date Status Bar

The bar directly under the Menu Bar is called the Date Status Bar and always displays the 
current date and time.    This date and time are the current date and time as set in your 
computer's clock/calendar.    The date in the Date Status Bar is call the System Date or Today's 
Date. 

You can quickly return the Page Date to the System Date by double clicking the mouse on the 
Date Status Bar. 

The plus or minus number in the middle of the Date Status Bar shows how many days the Page 
Date is before or after the System Date.



Changing Dates

The date that is displayed between two big arrows on the Daily Prioritized Task List, 
Appointments Schedule, Daily Record of Events, and Journal is called the Page Date.    This date 
represents the date of a page in your Franklin Day Planner.

When you change the Page Date, it is like turning the pages in your Franklin Day Planner to a 
new day.    You need this capability in Ascend in order to forward tasks to new days, plan tasks for 
future dates, review upcoming meeting notes, etc.

There are several ways to change the Page Date to another day:

1. You can go back one day at a time by clicking the big arrow to the left side of the Page 
Date with the left mouse button.

2. You can go forward one day at a time by clicking the big arrow to the right side of the 
Page date.

3. You can use the Goto menu to go to yesterday, today, tomorrow, forward a day, 
backward a day, forward a week, or backward a week.

4. You can use the Goto menu and then the Date sub-menu to pop-up a calendar.    From 
this "goto" calendar you can select the date that you want to go to. 

5. You can press the [F4] function key and the Goto Calendar will appear.    You may then 
use this calendar to change the Page Date.

6. You can quickly have the Page Date "jump" to the System Date (Today's Date) by double 
clicking on the Date Status Bar.

By experimenting with the different methods of changing the Page Date, you will notice that as 
you change the Page Date, the System Date shown in the Date Status Bar remains unchanged, 
but in the Date Status Bar, a positive or negative number will tell you how many days your Page 
Date is "from today."



Entering Tasks

To enter a task, simply move to the first empty line under the Prioritized Daily Task List column 
and type in the task.    To move between columns you can either use your mouse to click in the 
desired column and row or you can use the [Tab] key to move between columns and your up and 
down arrow keys to move between rows.

Each of the columns are explained below:

(Task Code) This column specifies the particular code to assign each task.    Valid codes each task 
are:

A blank code symbolizes that the task has not been acted upon.

This code symbolizes that the task has been completed.
This code symbolizes that the task has been forwarded to another day.    You may see the day in 

which the task was forwarded by using the View Statistics function.
This code symbolizes that the task has been deleted.
This code symbolizes that the task has been delegated to another person.
This code symbolizes that the task is currently in process but has not been completed yet.
This code symbolizes that the task that was delegated has now been completed.
This code symbolizes that the task that was in process has now been completed.

There are three ways to select the appropriate code for a task:

1. Click in the task code column or press the space bar.    This will bring 
up the Select Task Code dialog box allowing you to choose from a 
list available codes.

2. Use the right mouse button and click in the column.    Each time you 
click, the next task code will appear.    Stop clicking when you reach 
the code you desire.

3. Use the Group Action feature.

abc This is the prioritization column.    When you prioritize your tasks with the 
Prioritize Tasks menu option, this column will fill in automatically for you. 
You may, however, fill this information in directly if you desire.

Prioritized Daily Tasks This column is where you enter your task descriptions.

(Notes) This column indicates whether you have entered a note for the task or not.    If the box 
contains the notes icon, you have entered a note.    If it is blank, there are no notes for the task.    To enter 
or edit the notes for a task, either click in this column or press the space bar to activate the Task Notes 
dialog box.
Columns for Full View Only
Est Estimated number of time blocks that the task will take.
Act Actual number of time blocks that the task used to complete.
Category This column allows you to specify what category you would like to assign a task to.    The 
default category for all tasks is "None".    To access the different categories, either click the left mouse 
button in this column or press the space bar when you are in this column.    This will bring you the Task 
Categories dialog box.



Add Notes to a Task

Ascend allows you to assign a note for each task    and appointment that you enter.

Include on Index Page Check this box if you want this note to be included when you print your 
monthly index.

Print on Notes Page Check this box if you want this note to be printed on your Daily Record of 
Events.

Index Entry If you have selected to have this note printed on your monthly index, you 
can enter the index entry name.    This field will default to the name of the 
task or appointment.

Find Name This push button is used to merge information from your Address and 
Phone file into your task notes.    When you press the button, you will be 
able to select a name from your Address and Phone file.

Insert Break If you want to insert a break line that will be used when printing this 
information, press this button.    When you select this button, you will see 
a "ß" character.

Insert Date If you wish to insert the current date anywhere in your note, select this 
button.

Insert Time If you wish to insert the current time anywhere in your note, select this 
button.

OK,Cancel, and Delete Select the OK button when you are ready to save the note and exit.    If 
you wish to exit the note's dialog box and not save your changes, push 
the Cancel button.    If you wish to delete or clear out a note from a task 
or appointment, press the Delete button.



Prioritizing Your Task List

One of the nicest things about Ascend is the way it "walks you through" the prioritizing process 
"step by step."    Ascend uses the prioritizing methods taught by Franklin International Institute, 
Inc., and if you are familiar with how this method works, you will appreciate the easy approach 
Ascend uses to help you with this process.

You enter the prioritization process by selecting the Task Options menu and then select the 
Prioritize menu option.

The Unprioritized Task box lists all of the current Page Date's tasks that have not already been 
either completed, deleted, forwarded, or prioritizied.

As taught by Franklin International Institute, Inc. the first step to prioritizing process is to label 
each of your tasks, A, B, C, or D.    A definition of each priority follows:

A Tasks that must absolutely be completed today.

B These are important tasks that you would like to be able to do today, but you would not 
suffer significant consequences if you did not get them completed today.

C These are tasks that you will complete "if you get some time".    These are less important 
and not very urgent.

D These are tasks that you wish to do in the evening and will be printed at the bottom of 
your planner page.

You will notice that the first task in the Unprioritized Tasks box is highlighted.    Decide whether it 
is an A, B, C, or D task and click the corresponding button to prioritized the task.

If you come to a task that should not be prioritized because it is completed or you want to forward 
it, etc, simply select the appropriate check box to show that task has been completed, forwarded, 
delegated, etc.

Sometimes you may forget    what a task means.    You can use the View Notes button to see if 
there are any notes associated with a particular task.    If there are no notes associated with the 
task, you will hear a short beep.

Once you have categorized all your tasks into either A, B, C, or D tasks, you need to press the 
Rank button to put each task in a numerical order.

When you are all through prioritizing and ranking your tasks, press the OK button to return to your 
task list.



View Notes

This dialog box shows you the note associated with the task that you have highlighted on the 
Prioritized Tasks dialog box.    You cannot edit the note here.



Rank Tasks

After you have put each of your tasks into one of the 4 categories (A,B,C, or D), you need to rank 
your tasks.    Ranking is the process of determining the numerical order of your tasks.    For 
example, which of your A tasks should be first, second, and third.

When you see this dialog box, you will see all of your A,B,C or D tasks in the Unranked Tasks list 
box.    Select the task that you want to be first and then press the Rank 1 button.    This will move 
the task over to the other side of the dialog box and allow you to select the next task.    The Rank 
1 button will now change from Rank 1 to Rank 2.    Continue ranking all of your tasks.    Once you 
have ranked all of your tasks, select the Done button.

You may also select the next task to be ranked by double clicking on the task.



Inserting a Task

One of the advantages to using an automated planner system, is the ability to insert a task into 
your task list and keep the list prioritized.    To do so, simply move the cursor to the row of the task 
you would like to insert a task before, select the Edit menu and then Insert.    Ascend will insert a 
blank line for the new task and keep the prioritized rankings in order.



Deleting a Task

To delete a task, simply move the cursor to the task to be deleted, select the Edit menu and then 
Delete.    Ascend will keep your list in a prioritized order.



Copying a Task

To copy a task to another Page Date and still leave the task on the current Page Date, move the 
cursor on the task to be copied, select the Edit menu and then Copy.    The same calendar that 
you see when you are changing Page Dates will appear and you can select the date to copy the 
task to.



Moving a Task

Moving a task is identical to copying a task except that you use the Move option and the task will 
be deleted from the Page Date where the task was moved from.



Group Action

You use the group action to quickly assign task codes to all of the tasks that have not been 
completed, deleted or forwarded.

To access the group action, pull down the Task Options menu and then select Group Action.

All tasks that do not already have a task code will appear in the upper box labeled Tasks that 
Need Actions.    Select the appropriate action for the highlighted task by pressing the necessary 
button (Completed, Forwarded, Deleted, etc.).

There are seven smaller buttons for the next seven days of the week.    These buttons are used 
as a quick way to forward tasks to sometime within the next seven days without having to use the 
Goto calendar.    These seven buttons will change depending on the Page Date.

The Complete & Copy button can be used to mark a task as completed on the current Date 
Page but then still copy it to another date via the Goto calendar.    This is a handy feature for 
"ongoing" tasks.



Forwarding with the Goto Calendar

When you forward a tasks, you will get the Goto Calendar also known as the Monthly Calendar.    
You will notice that this is the same calendar used when you select the Goto/Date menu options.

Next to some of the dates a small icon might appear (cake, closed sign, briefcase, palm tree, etc.) 
representing a Special Day    These icons help you to avoid forwarding tasks to days when you 
will not be available.

You may select the date you wish to forward the task to by double clicking on the desired date or 
by typing in the desired date that you wish to proceed to.

Sometimes it is useful to know what tasks, appointments, and/or special day items are on a 
particular day before forwarding a task to it.    To view a date's tasks, appointments, and special 
day items, click the mouse on the desired date one time.    The date will become marked with a 
highlighted box.    You can now check the View Detail box and any tasks, appointments, and/or 
special day items will be displayed in the scroll boxes at the right of the calendar.

Using the calendar, you also have the option of forwarding tasks to your Master Task List instead 
of a date.    To do this, click your mouse on the down arrow to the right of the Master Task List 
category box.    Your five Master Task List categories will be displayed and you may select the OK 
button and the task will be moved to the specified category in your Master Task List.



Recurring Tasks

A recurring task is a task that must be scheduled at consistent intervals.

Ascend allows you to schedule recurring tasks either directly from the Prioritized Daily Task List or 
via the Values and Goals section.

To Add a recurring task, select the Task Options menu and then Recurring Tasks. 

Task Description Enter the description of the recurring task that you want to have appear 
on your Prioritized Daily Task List.

Default Priority Enter the default priority for the task, A, B, C, or D or leave blank for no 
default priority.

Starting Date Enter the date that you want this task to start appearing on your Daily 
Task List.

Ending Date Enter the date that you want this task to stop appearing on your Daily 
Task List.

Day If you would like the recurring task to only appear on a specific day in the 
month, enter the day here.

Month If you would like the recurring task to only appear on a specific month, 
enter the month here.

Weekdays Check the weekdays that you would like the recurring task to appear on 
your Daily Task List on.

Week Number Check the week number that you want the recurring task to appear on 
your Daily Task List on.    These week numbers correspond to the week 
number in the month.

Save Press this button to save the current recurring task.

Find Press the button to find an existing recurring task. 

New Press this button to allow you to enter a new recurring task.

Delete Press this button to delete the current recurring task.

Prev Press this button to view the previous recurring task in the recurring task 
file.

Next Press this button to view the next recurring task in the recurring task file.

Exit Press this button to exit the recurring tasks dialog box.

Performance When you select this check box, you will see a calendar which shows 
you how you have performed with the current recurring task.    Days that 
you should have completed the recurring task will show a circle.    Days 
that you actually completed the task will show as a check mark.    At the 
bottom of the calendar you will see some statistics about the task for the 
month.





Repeating Tasks

A "Repeat Task" is a special task that repeats once finished.    These are tasks that once you have 
completed, you want to re-schedule the task again after so many days.    Repeats Tasks are 
different from recurring tasks in that they are only re-scheduled after they are completed, and that 
the reschedule date is based upon the completion date.

To schedule a repeat task, simply add the task to your Prioritized Daily Task List on the first date 
you wish to schedule the task.    After you have entered the task, pull down the Task Options 
menu and then select Repeat Task.    A dialog box will appear asking you how many days to wait 
before re-scheduling this task once it has been completed.    You can then enter the correct 
number of days and select OK.



View Statistics

To view the statistics of a particular task, move your cursor to one of your tasks, pull down the 
View menu and select Statistics.    This option will display a dialog box containing misc. statistics 
about the task.



Sort Tasks

In the very rare occasion that you move your tasks and/or priorities around and need to re-sort 
them by their prioritized order, you can do so by pulling down the Task Options menu and 
selecting Sort Tasks.



Start Timer

Ascend has a timer function allowing you to time how long you work on a task.    To start this 
timer, pull down the Task Options menu and select Start Timer.    To stop the timer select Stop 
Timer from the Task Options menu.    When the timer is stopped, you will be given a report on 
how many hours and minutes elapsed since the timer was started and also how many Time 
Blocks were used.



Printing Your Task List

Ascend will print your Prioritized Daily Task List right on the pages on your Franklin Day Planner. 
To do this, make sure your Date Page is on the correct date and put that day from your Franklin 
Planner in your printer.    Pull down the Print menu and select Print Tasks, Appointments & 
Notes.

Print Prioritized Daily Task List

Check this option if you wish Ascend to print your Prioritized Daily Task 
list on your Franklin Planner page.

Print Appointment Schedule

Check this option if you wish Ascend to print your Appointment Schedule 
on your Franklin Planner page.

If both Print Prioritized Daily Task List and Print Appointment 
Schedule have been selected, Ascend will print both your tasks and 
appointments at one time on the left side of a Franklin Day Planner 
page.

Print Daily Record of Events & Notes

Check this option if you wish Ascend to print your Daily Record of 
Events, Task Notes, Appointment Notes, etc. on your Franklin Daily 
Record of Events Page.

Lines to Skip If you have already written on your Franklin Day Planner page for the 
selected date, you may specify how many lines you wish Ascend to skip 
before printing.    This option is only valid for your Prioritized Daily Task 
List and your Daily Record of Events.

Pause between Pages

If you have selected to have both tasks/appointments (left page) and 
notes (right page) printed, check this box if you would like Ascend to 
pause between these pages to allow you to load them into your printer 
manually.

Include Journal with Daily Record of Events

Check this option if you desire any entries for the current Page Date 
found in your journal to be printed along with the other note items on your 
Daily Record of Events.

Print on Blank Page Occasionally you might ruin a page from your Franklin Planner (printer 
was not setup properly, put wrong date in printer, paper jam, etc.).    
Should you ruin one of your pages, you can still print your task list and 
record of events on a blank sheet of paper by checking this option.

When you are ready to print, press the OK button.



Printing Monthly Index

To print a monthly index of your notes, pull down the Print menu and select Print Monthly Index. 
Select the desired month, insert paper into your printer, and then select OK.



Select Task Codes

Select the task code that you desire to perform on the task and then select the OK button.    If you 
select the Forward task code, you will be presented with the Goto calendar to select the 
appropriate date to forward the task to.



Task Categories

Select the appropriate task category by using the arrow keys or the mouse.    If you would like to 
add a new category, simply type in the name of the new category and press the OK button.



Find a Recurring Task

Select the recurring task from the list and press the OK button.    If you desire to delete one of the 
recurring tasks in the list, select the task and press the Delete button.



Appointment Schedule

Ascend alllows you to track your appointments and print them right on your Franklin Day Planner 
pages.    The program will warn you if you try to schedule an appointment that conflicts with 
another meeting.    Just like recurring tasks, you can incorporate recurring appointments.    Also, 
like tasks, appointments can have notes attached which can be printed on your Daily Record of 
Events.    An alarm can be set for any and all appointments and then "snoozed" when it sounds.

See Also:

Changing the Page Date
Entering Appointments
Adding Notes to an Appointment
Setting Alarms
Moving Appointments
Copying Appointments
Recurring Appointments



Entering Appointments

To enter an appointment, simply move to the desired time and enter in a description for the 
appointment.    To move up and down the schedule, you can either:

1. Use the scroll bar to the right of the schedule to move to the time that you desire.

2. Use the up and down arrow keys on the keyboard to move you to the line that you desire.

3. Use the mouse to click on the line that you desire to go to.

The columns for the appointments window will now be discussed.

Appointment Schedule This is where you type in the appointment.

(Alarm) This is the alarm column where you can set alarms for your appointments.
(Notes) This column allows you to attach a note to the appointment.
(Time Blocks) This column allows you to specify how many time blocks the appointment will 

take.



Setting Alarms

To set an alarm for an appointment, click your mouse on the row of the appointment in the Alarm 
column or move your cursor to the correct row and press the space bar.    You can either enter a 
time directly or you can use the up and down arrow buttons to change the default time.

When the alarm does sound, you will be given the option to snooze the alarm to sound again at a 
later time.



Moving Appointments

To move an appointment to another date or time, put the cursor on the appointment you wish to 
move, pull down the Edit menu, and select Cut Appointment.    The appointment will disappear 
and has been moved to a temporary location in your computer's memory.    Next, move your 
cursor to the location where you wish to move the appointment to, even on a different page date, 
pull down the Edit menu, and select Paste Appointment.    The appointment reappears in its new 
location.



Copying Appointments

The procedure to copy an appointment is the same as moving an appointment except you use 
the Copy Appointment option from the Edit menu instead of Cut Appointment.    Unlike Cut 
Appointment, Copy Appointment will leave the original appointment alone but still allow you to 
paste the appointment elsewhere.



Recurring Appointments

Recurring appointments work the same as recurring tasks.    The major difference is that you can 
specify the number of time blocks required and the time of the recurring appointment.



Daily Record of Events

Ascend allows you to enter and save notes into your Daily Record of Events and then print these 
items in your Franklin Day Planner.    A quick search routine allows you to find entries quickly in 
your Daily Record of Events.    Information from your Address and Phone file can be quickly 
merged into an entry, thus allowing you to include phone numbers, addresses, directions, etc., 
instantly with an entry.

The Daily Record of Events is basically a mini word processor where you can record phone 
conversations, thoughts, ideas, anything!

See Also:

Adding Entries for Your Monthly Index
Edit Menu
Time, Date, Break, and Name



Adding Entries for Your Monthly Index

If you would like to create an entry to be included on your Monthly Index for something in your 
Daily Record of Events, simply select the Index menu and a dialog box will appear asking for the 
name of the index entry.



Edit Menu

Use the Edit Menu to delete, copy, paste, or move information.    You can also use this menu to 
undo your last edit.



Time, Date, Break and Name

The Time, Date, Break, and Name functions of the Daily Record of Events' module are the same 
as Insert Time, Insert Date, Insert Break, and Find Name as described in Task Notes.



Address and Phone

Ascend maintains a categorized address and phone directory that can be printed for your Franklin 
Day Planner.    Phone numbers can be dialed directly from the computer if you have a modem.    
When dialing a number for you, the program will automatically send the appropriate prefix and/or 
suffix codes for in-state, out-of-state, and local calls.    A "speed dial" feature makes it extremely 
easy to dial certain numbers that you call frequently.    A "filter" feature allows you to quickly view 
or print only a select group of entries, such as all golf courses, all hotels in California, all board 
members, etc.    If desired, a "VIP" feature can be used to help secretaries screen incoming calls.

See Also:

Adding an Entry
Phone and Address Data Entry
Finding and Editing a Record
Index
Filter
Modem Settings
Print
Importing Records



Adding an Entry

To add a name to your Address and Phone file, pull down the Name menu and then select Add.    
(You can also press the Insert key to add a new entry.)    Ascend will then proceed to the Phone 
and Address Data Entry screen.



Phone and Address Data Entry

Most of the fields in this dialog box are self-explanatory, with the following added detail:

Category Ascend allows you to categorize your Address and Phone entries, if 
desired.    You can then use Ascend's "filter" feature to find all golf 
courses, restaurants, hotels, business associates, etc.

To categorize an entry, click your mouse on the down arrow to the right of 
the category input box.    A box will appear showing all of the categories 
you have entered so far.    You may either use your mouse to select an 
existing category, or you may type in a new category if needed.

Description When adding a new record, the five Description fields will default to 
what you have specified in your preferences.    You may keep these 
defaults or enter new ones.

VIP Check this box if the entry is a VIP.    You could then use the filter feature 
of Ascend to print a listing of your VIP's for your secretary.    Your 
secretary could then interrupt you in meetings if a VIP calls or visits.

Speed Dial If you have a modem and are planning on using Ascend as an auto 
dialer, check this box if the entry is one that you call often.    Entries with 
the Speed Dial box checked can be called quickly from anywhere in 
Ascend by pressing the F2 function key.

List by Company

List by Name When Ascend displays your entries on the directory screen (the one that 
looks like a phone book), it will list them in alphabetical order.    If you 
would like the entry you are adding to be displayed based on the last 
name, check the List By Name box.    If, however, you would like the 
entry to be listed by the company name, check the List by Company 
box.    If you would like to have the entry listed by both the last name and 
the company name, check both boxes.

Print The Print button can be selected to quickly print all of the information in 
the current record you are editing. 

Dial Select this button to quickly dial (using your modem) the current record 
you are editing.



Finding and Editing a Record

To move from page to page on the phone directory screen, you can do one of the following:

1. Click your mouse on the letter tab for the page you desire.

2. Enter the desired letter by typing it in the Finding box.

3. Use the right and left arrow keys on the keyboard to page through your listings.

To select an existing record for editing or viewing, simply move your cursor to the desired record 
and press [Enter] or double click on the record's name with your mouse.

To quickly search for a particular name, you may type the name in the Finding box, and Ascend 
will search for the name as you type.    When you arrive at the desired name, press [Enter] to edit 
or view the record.



Index

If you would rather view all of your entries alphabetically in one scroll list instead of one scroll list 
per letter, select Index on the menu bar.    To return back to the normal display method, select 
Index again.    Selecting this option will toggle you between the two viewing modes.



Filter

You may set up a "filter" in Ascend's Address and Phone module to exclude individuals from your 
index listings and printouts who do not meet certain criteria.

To enter your filter criteria, pull down the Filter menu and select Set Filter.    A screen will appear 
exactly like the Address and Phone dialog box.    Enter in any criteria you wish to filter by and then 
press OK. 

Once you have set your filter's criteria, you must make sure you have turned the filter on.    There 
are two ways to do this:

1. Select Use Filter from the Filter menu.    (Note: If there is a check mark by the Use Filter 
menu option, then the filter is already on and selecting it again will turn it off.)

2. Check the Use Filter box at the bottom of the Address and Phone directory screen.

To turn the filter off, reverse one of the above options.

To reset your filter's criteria, select Set Filter from the Filter menu and select the Reset push 
button and then OK.    You can tell that your filter criteria has been reset and is currently empty if 
the Use Filter box under your Address and Phone directory has been shadowed.



Modem Settings

If you have a modem and desire to use it with Ascend as an auto dialer, select the Modem menu 
option to set Ascend's modem configuration.

Ascend will automatically send a prefix and/or suffix before certain types of calls.    These prefixes 
and suffixes can be set from the Modem menu option.

Ascend automatically detects if a call is Local, In State, or Out of State by how the number is 
entered in the Address and Phone file:

1. If a phone number is 8 characters or less (including the hyphen), Ascend assumes the 
number is Local.

2. If the phone number is 10 characters or less but begins with the number 1, it assumes 
the call is In-State.

3. If the phone number is 11 characters or more and begins with the number 1, it assumes 
the call is Out-of-State.



Printing 

To print out your directory for use in your Franklin Day Planner, select the Print menu option. 

Listing Type Select what type of listing you wish to print.

Use Filter Check this box if you desire your printout to only include those records 
that meet the criteria you have set up in the filter.

Page Break Between Letters

Check this box if you want a form feed after each letter.    If you want all 
of your names to print on as few pages as possible, do not check this 
box.

Starting and Ending Enter a starting and ending letter for your report.

Page Ascend will automatically flip between the right and left page, but you can 
specify which side of the page you wish to begin the report on.

Select the OK button when you are ready to print.



Importing Records

If you already have a significant amount of data on a computer that you wish to import to 
Ascend's Address and Phone file, you can use Ascend's import routine.    To be able to use 
Ascend's import routine, you must have a data file that is Line Delimited and only contains 
information pertinent to Ascend's Address and Phone file.

To use this routine, pull down the Name menu and select Import.    Two scroll lists will appear.    
Double click on the first item in your data file, then double click on the second item, and so on.    
After you have selected all of the pertinent fields, enter the name, drive, and path of the file you 
wish to import.

After you have entered the appropriate information, select the Import push button, and Ascend 
will read the data into your file and append it to any records you already have in Ascend's 
Address and Phone file.



Values and Goals

The real power of Ascend is seen in the Values and Goals module.    This module allows you to 
enter your Productivity Pyramid, or Personal Constitution, as taught by the Franklin International 
Institute, into your computer.    The program outlines your Governing Values, Long-Range Goals, 
and Intermediate Goals in a logical pyramid which can then be printed in an attractive format for 
your Franklin Day Planner.    Ascend allows you to evaluate yourself in each area of your Personal 
Constitution on a rating scale of 1 to 10 and then will automatically introduce specified items from 
your Intermediate Goals into your Prioritized Daily Task List.    The real power here is in 
automatically including the goals that need work into your Prioritized Daily Task List.    You can 
even view a progress report on how well you are doing.    Because of the structured system 
employed by Ascend, creating your Productivity Pyramid is easy and fun, and if you need to edit it 
later, doing so is a snap.

See Also:

Values and Goals Pyramid
Attaching Intermediate Goals to Your Task List
Edit Evaluation
Print



Values and Goals Pyramid

The goal setting process, as explained by Franklin International Institute, Inc., uses the 
Productivity Pyramid which consists of four levels:

1. Governing Values.

2. Long Range Goals

3. Intermediate Goals

4. Daily Tasks

Ascend allows you to enter these four levels using a "tree" approach.    For example, someone 
could have 10 Governing Values, 50 Long Range Goals (an average of 5 per value), and 250 
Intermediate Goals (an average of 5 per Long Range Goal). 

To enter items under each level, select the Add button.



Attaching Intermediate Goals to your Daily Task List

After you have added the first three levels of your pyramid: Values, Long Range Goals, and 
Intermediate Goals, you can introduce some of your intermediate goals into your daily task 
list.    The average person will have between 100 and 300 Intermediate Goals, as you probably 
will also.    It is not realistic for you to work on all of your Intermediate Goals at one time.    
Therefore, you should evaluate your goals often and select two or three of your intermediate 
goals at any given time by introducing items from these goals into your Prioritized Daily Task List.

To have items from your Intermediate Goals appear on your task list, select the Add key from the 
dialog box of the Intermediate Goal you wish to "work on".    A screen will appear that looks and 
function exactly like the Recurring Tasks feature.    The only difference will be that this recurring 
task will be attached to your Intermediate Goal.



Edit Evaluation

Ascend allows you to evaluate yourself by rating each of your Intermediate Goals on a scale of 1 
to 10 (1 being poor and 10 being excellent).    Ascend will then use your Intermediate Goal ratings 
to calculate a rating for each of your Long Range Goals.    Ascend will then use the calculated 
rating from your Long Range Goals to calculate a rating for each of your Values, and then it will 
calculate one overall rating for your entire life based on the ratings of your Values.

This approach is fairly accurate because how well you are doing overall in your life is a factor of 
how well you are doing in each of your Governing Values, and how well you are doing in each of 
your Values is based upon how well you are doing with your Long Range Goals which in turn is 
based upon how well you are doing with your Intermediate Goals.

To evaluate your Intermediate Goals, select the Edit Evaluation menu options.    This will bring 
up a list of all of your Intermediate Goals.    As you scroll through each of your Intermediate Goals, 
you will see that goal's evaluation in a box below where you can change it. 

Select the OK button when you are all done changing the evaluations.



Printing Values and Goals

Use the Print menu option to print your Values and Goals on the Franklin Day Planner forms.    
Depending on which section of the values and goals you are on, you will use different forms. 

If you are on the first "Personal Constitution" section, selecting the Print menu option will print all 
of your Governing Values on the "Values" sheet in your Planner.

If you are editing an existing Governing Value, selecting the Print menu option will print only that 
one Governing Values on the "Values" sheet in your Planner.

If you are editing an existing Long Range Goal, selecting the Print menu option will print that one 
Long Range Goal with its corresponding Intermediate Goals under it on the "Goal Planning" sheet 
in your Planner.



Red Tabs

Red Tabs is an Ascend module that allows you to quickly enter, store, and print misc. information 
with your computer -- a mini word processor, only faster.    This feature is used similarly to the red 
tabs in the Franklin Day Planner -- a catch-all for misc. items.

There are an infinite number of ways to use Red Tabs, limited only by your imagination.    To get 
your imagination flowing, here are some examples of what you might use the Red Tabs for:

* A wish list of books you would like to read

* Gift ieas for your spouse and others

* A list of items to take when you travel

* A list of items to take when your family goes camping

* Business ideas

* Shopping lists

* Things to ask your boss when he calls from out of town

* A back-up log of when you backed up your data files

* And on, and on, and on...

See Also:

Red Tabs File Menu
Red Tabs Edit Menu
Printing Red Tabs
Searching for Text in the Red Tabs



Red Tabs File Menu

Each Red Tab item is kept is a separate file.    To Add, Edit or Delete files from your Red Tabs, you 
need to use the File menu option.

New This option clears the Red Tab screen and allows you to create a new 
Red Tab item.

Find This option allows you to find an existing Red Tab item and open it up for 
editing.

Save This option saves any changes you may have made to an existing Red 
Tab item.    If the item is a new Red Tab item, you will be prompted to 
type in the Red Tab's description before saving the file.

Save As This option allows you to save the current Red Tab item into a new Red 
Tab.    You will be prompted to enter in the Red Tab's new description 
before saving the file.    You will need to use this option when changing a 
Red Tab's description.

Delete This option allows you to delete an existing Red Tab.



Red Tabs Edit Menu

Because the Red Tabs module is basically a mini word processor, there are several editing 
features that you may take advantage of.

Undo This option undoes your last editing operation.

Cut This cuts the selected text and copies it to the clipboard.

Copy This option copies the selected text to the clipboard but leaves the 
selected text where it is.

Paste This option pastes any text that is in the clipboard to the location where 
your cursor is currently positioned.

Delete This option deletes any text that is currently selected but does not copy 
it to the clipboard.

Word Wrap This turns on the Word Wrapping mode.    If the Word Wrapping mode if 
OFF, you will need to press the [Enter] key to terminate lines.    When it is 
ON, Ascend will wrap to the next line automatically.

Font This option allows you to select the font that you want to display the text 
in.    This does not affect your printing of the Red Tab.



Printing Red Tabs

You may print out your red tabs by selecting the Print menu option.    The red tab will be printed 
on plain white paper and will print according to the planner size that you are using.



Searching for Text in the Red Tabs

You may use the Search menu option and the Find sub-option to find text in your red tab file. 

Search For Enter the text that you desire to search for.

Case Sensitive If you desire your search to be case sensitive, check this button.

From Beginning of File

If you desire the search to start at the beginning of the file, check this 
button.    Otherwise the search will begin from the current position in the 
file.

Select the OK button to begin the search.

You may use the Search menu option and the Find Next sub-option to repeat the last find 
operation.



Finding Red Tabs

Select the Red Tab file that you desire to edit and press the OK button or double click on the 
desired file.

If you desire to delete one of the Red Tab files that you see in the list, simply highlight the Red 
Tab item and press the Delete button.



Master Task List

Ascend allows you to have up to five different Master Task List categories where you can 
temporarily "store" tasks that you would like to do someday but that you don't want to schedule on 
a particular day yet -- kind of a "someday when" list.    The Master Task List is like a "back burner" 
and is a handy feature for storing those tasks that you don't want to forget about, but you know 
you don't have time to complete in the near future. 

You can easily and quickly move tasks from your Prioritized Daily Task List to the Master Task List 
and vice versa.    In fact, Ascend will even prompt you to move a task to the Master Task List after 
you have forwarded it a specified number of times.

There are five different categories in your Master Task List.    To switch between categories, click 
on one of the big arrows to either side of the category name box.

Search This menu option will allow you to search through all of your data for a 
particular task, phrase, note, appointments, etc.

Delete This menu option will allow you to delete the current task that you are on 
from the Master Task List.

Move This menu option will allow you to move the current task that you are on 
to your Daily Prioritized Task List.    When you select this option, you may 
use the Goto calendar to find the day that you want to move the task to.

Print This option allows you to print your Master Task List on planner sized 
blank paper.

Category This option allows you to select the Master Task List category that you 
would like to view or modify.



Focus

If you use a computer during the day, the Focus feature allows you to view and concentrate only 
on the highest prioritized task that has not yet been completed from your Prioritized Daily Task 
List.    Focus does this by "blocking out" everything else on your computer's monitor except for a 
"worksheet" containing all of the information on the current task you are working on, thus making 
it possible to really focus in on the most important task at hand.    You may change any of the 
information on this work sheet and Ascend will automatically update your Master Task List with 
the new information.

Next Task This option will allow you to skip the task you are working on and "peek 
ahead" to the next task.    This is most useful if the task that you are 
currently working on cannot be completed at this point for some reason.

Previous Task This option will allow you to backup to the previous task that has not 
been completed.

Completed By selecting this menu option, the current task that you are working on is 
given a check to show that it is completed and then the next task that 
needs to be completed will be brought up.    (The map will be displayed 
after each task is marked as completed.)

Map This menu option will bring up a quick chart showing you how many 
tasks you have to do and how many have been completed.

Insert This menu option will allow you to insert the Time, Date, Break 
Character, and Name into the notes for the task you are working on.



Weekly View

Weekly view will quickly and graphically show you one week with all appointments, special days, 
and tasks listed for each day.

A summary of each day will appear under the week day heading (Sunday, Monday, Tuesday, 
etc.).    For each of the seven days this summary will show:

* Appointments

* Number of Tasks

* Any special day items

In addition to the summary information for each of the seven days, Weekly View displays detailed 
information about one of the seven days.    This detailed information is displayed along the bottom 
of the Weekly View window.    The day for which the detail is being displayed is designated by its 
name box being highlighted.    To change the day for which the detail is being displayed, simply 
select a different day by clicking on its name box.    (Keyboard users:    Use the Goto menu option 
to change the detailed day.)

Goto This menu option allows you to select which day of the week you want to 
"zoom" in on.    Also this menu option allows you to select a different 
week range to view.

Print This menu option will allow you to print your weekly view to the Franklin 
Weekly Schedule form.



Turbo File

Turbo File is a new concept introduced by Ascend that allows you to quickly find "things".    A 
"thing" could be a magazine article you once read and found interesting, a statement you heard 
and wanted to remember, a report your boss gave you, a piece of mail you might someday want 
to find, etc.    Simply think of Ascend's Turbo File as a very sophisticated in/out box where you can 
locate items in seconds.

Turbo File is the cure for the "I wish I could only remember where I read that..." blues.    And the "If 
I would only have saved that letter..." groans.    And the "I wish I would have kept that information, 
I know I would need it someday..." gloomies.

Turbo File is basically a dialog box that allows you to fill in information, save it, and then retrieve 
that information at a later date.    The fields for the dialog box are explained below:

Description Enter the description of the item that you are filing.    You may search by 
this description at a later date so use a unique description if possible.    
For example, if you had read an article about stocks, your description 
might be Stocks for the 90's.

Key Words Enter up to five Key Words that you might want to use when trying to 
find this item in the future.    For example, if you were filing an article 
about stocks, some of your key words may be Stocks, Wall Street, etc.

Location Enter the location where you will be able to find this article in the future.    
You may enter a magazine issue, a location in your office, a filing cabinet 
number, a folder number, etc.

Category You may either select from an existing category by clicking your mouse 
on the down arrow next to the Category box, or you can enter a new 
category by typing it in the box.

Type The Type field is similar to the Category field in that you can either 
select an existing Type or enter a new one.

Date Entered This field will default to Today's Date and you can leave it alone, or you 
may enter a date of when you entered this file.

Notes You can enter a more detailed description of the filed item, or type 
anything about the item that you want to remember in this section.

Save After you have entered all of the necessary information, select the Save 
push button and    Ascend will save the record and clear the screen for a 
new entry.

Find To find records that you have entered into Turbo File, select the Find     
push button.    You may then perform a search to find one of your filed 
items.

New If you want to start on a new item without saving the current item that 
you are working on, you may press the New push button.

Delete If you want to delete the current Turbo File item that is displayed, press 
this button.



Prev If you want to view the previous item the Turbo File, press this button.

Next If you want to view the next item in the Turbo File, press this button.



Finding Turbo File Records

To find an existing Turbo File record, you have several options:

1. You can type in the first few letters of the Description and then select the Search push 
button.

2. You can type in one or more of the Key Words and then select the Search push button.

3. You can do a combination of the above two items.

If you want Ascend to display all of your Turbo File record, simply select the Search button 
without entering anything in the Description or Key Words boxes.

When searching for a record based on Key Words, you can select to either have Ascend require 
that only one of the Key Words specified be found in a record to list it or that all of the Key 
Words specified must be found in a record to list it.

When you have found the record that you were looking for and you want to view and/or edit it, 
you can either highlight the item and select OK or double click on the item.



Special Days

Ascend allows you to flag "special days" such as recurring holidays, birthdays, anniversaries, 
etc., and nonrecurring days such as vacations and business trips.    Once specified, these days 
will be designated with a special icon on your goto calendar and weekly view windows, thus 
helping you to avoid these days if necessary when scheduling meetings and tasks.

Special days do not print on your task list.    The main purpose of designating a Special Day is 
to warn you when scheduling tasks and appointments to possibly avoid these days.    For 
example, you would probably not want to schedule a meeting on Christmas or while you will be 
out of town on a business trip or vacation.    Therefore, if you want to remember to purchase a 
birthday present for your spouse, you should enter a recurring task about 5 days before your 
spouses birthday: Buy Birthday present for..., since recurring tasks Do appear on your task list.

Description Enter the description of the special day.    For example Christmas.

Starting & Ending Dates

Enter the starting and ending dates for the special day. 

Day Enter the day of the month (if applicable) of the special day.    For 
example, Christmas is the 25th of the month.

Month Enter the month number (if applicable) of the special day.    For example, 
Christmas is the 12th month.

Category Select the appropriate category for the special day.    The valid categories 
are:

The closed sign symbolizes a holiday.

The palm tree symbolizes a vacation.
The cake symbolizes a birthday.
The ring symbolizes an anniversary.
The brief case symbolizes a business trip.
The exclamation point is for misc. special days.

Week Days Check the weekdays (if applicable) that this special day will take effect on.    If you have 
specified day, you need not check these fields since Ascend knows which day the special day is on.

Week Number Check the week numbers (if applicable) that this special day will take 
effect on.

Save Press the Save button when you want to save changes to the Special 
Day record that you are working on.

Find Press the Find button to find an existing Special Day record for viewing 
or editing.

New Press the New button when you want to lose the changes that you have 
made the current Special Day and allow you to enter a New Special Day.

Delete Press this button when you want to delete the current Special Day 
record.

Prev Press this button when you want to save the current Special Day record 
and bring up the previous Special Day record.



Next Press this button when you want to save the current Special Day record 
and bring up the next Special Day record.



Finding Special Day Records

Select a Special Day from the list of all your Special Days and press the OK button or double click 
on the desired item.    If you desire to delete one of the displayed Special Days, select the day 
and press the Delete button.



Journal

Ascend's Journal is very similar to the Daily Record of Events, but is kept separate should you 
wish to print just your Journal entries.    Also, special "red letter" days can be marked, such as 
"our son left for college today."    Just like the Daily Record of Events, entries can be indexed 
and/or found using the search features of Ascend.

Edit The Edit menu option will allow you to Cut, Copy, Paste, Undo, and 
Delete text in your Journal.

Print The Print menu option allows you to print different entries in your 
Journal.

Goto The Goto menu option allows you to jump to different days and view/edit 
journal entries for those days.

Index - Add Entry The Index/Add Entry menu option allows you to add a new special Index 
entry for your journal entry.

Index - Show Entries This option displays a box showing you all of the index entries for the 
date you are working on.

Search This option proceeds to the Ascend search routines.

Time This option will insert the current time into your journal entry.

Date This option will insert the current date into your journal entry.

Break This option will insert a break character into your journal entry.    When 
you entry is printed out, the break character will be expanded into a solid 
line dividing the text before and after the break character.

Name This option will allow you to find a name in your phone and address files 
and merge the information into the journal entry.

See Also

Printing Journal Entries
Journal Index Entries



Printing Journal Entries

You have several options when it comes to printing your    journal.

Journal Index Check this box if you desire to only print a journal index to special 
events.

Journal Check this box if you desire to print your actual journal entries.

Starting Date Enter the starting date for the printing.

Ending Date Enter the ending date for the printing.

Print only 1 Date per Page

Check this box if you desire each journal entry to be on its own page.

Pause Between Pages

Check this box if you desire Ascend to pause between pages to let you 
insert a new sheet of paper if you are using manual feed on your printer.

Print Out Size Select the appropriate size of your journal print out.

When you are ready to begin printing, press the OK button.



Journal Index Entries

Journal index entries are a way to mark a day in your journal with special entries, such as "Bill 
went off to college today", or "Preston was born".    These entries can be printed out separately 
from the rest of the journal and made into a "table of contents" for your journal.

Index Entry Enter the index entry you want specified for the event.

Special Entry Check this box if you want this index entry printed in BOLD lettering 
when you print out the index.

Current Index Entries This box displays the currently defined index entries.

Press OK to save the new index entry or press Cancel to abort.



Favorite Quotes

The Favorite Quotes feature of Ascend allows you to store and retrieve your favorite quotes.    
Ascend comes with a few quotes as examples.    If you like, you can configure Ascend to "pop up" 
one of the quotes each morning when you start the program.    Ascend also provides a search 
feature so that you can quickly find specific quotes, all quotes associated with "time 
management" for example.

The format for entering and finding quotes is very similar to the Turbo File features.



Reports

Ascend uses the Reports module to print or display certain time management reports.    As of this 
version of Ascend, the only report in this module is the Task Statistics Report.

The Task Statistics Report gives a breakdown of how you are spending your time.    This report 
is only valid if you are using Ascend's advanced time management features. 



Tools and Utilities

The Tools and Utilities module is used to enter your registration information and change the name 
of a category.

Do not confuse the Tools and Utilities module (designated by a hammer) with the Ascend Tools 
& Utilities program(designated by three tools) located on the Windows Program Manager.    
These items are different and perform different functions.

See Also

Registration
Edit Categories



Edit Categories

This option is used to change the name of an existing category in one of the following areas of 
Ascend.

* Task Categories

* Phone Categories

* Turbo File Categories

* Turbo File Types

* Quote Categories

For example, if you had entered a Task Category of Phone and you wanted to change it to 
Telephone, you would pull down the Edit Categories menu and then select Task Categories. 

To change the Phone category to Telephone you would highlight phone in the list of categories 
by clicking on it one time with your mouse or by moving down to it with the down arrow on the 
keyboard.    the word Phone would now appear int the Edit Category box also.    Next, you would 
press the [Tab] key to move the cursor to the Edit Category box.    Type Telephone in the Edit 
Category box and press the [Tab] key.    Notice that the category Phone is now changed to 
Telephone.    Select the OK when you are finished making changes.



Ascend Tools & Utilities Program

The Ascend Tools & Utilities program is not a module run from within Ascend, but is a program 
run from the Windows Program Manager.    This program allows you to:

* Make back-up copies of your Ascend data files.

* Restore back-up copies to your hard drive.

* Reindex your Ascend files

Backup This menu option allows you to back up your Ascend data files from your 
Ascend sub-directory to a floppy diskette.    If your data will not fit on only 
one floppy diskette, Ascend will ask you for additional diskettes.    
Ascend will erase any data on the floppy diskette used for backing 
up, but it will not format the diskette.    Diskettes used for backing 
up must already be formatted.

Restore This option allows you to restore data from your floppy diskette to your 
Ascend sub-directory on your hard drive.

Fix Header This option will reconstruct critical data that may have been corrupted in 
the data files.    Do not run this routine unless specifically instructed 
by an Ascend Support Technician.

Reindex File This option is used to "clean up" any potential problems your data files 
might have due to power failures, poor backups, etc.    Contact Ascend's 
Technical Support department for more instructions on this function or 
refer to your users manual.



Ascend
A computer software program designed specifically to be used with the Franklin Day Planner.



 Backup
A routine that allows you to back up your Ascend data files from your Ascend sub-directory to a floppy 
diskette.



Click
Quickly press and release a mouse button, usually the left one.



DOS
Disk Operating System



Double Click
Quickly click the left mouse button twice.



Drag
Press the left mouse button and hold it down while moving the mouse.    This will allow you to move items, 
make selections from pulldown menus, etc.



Focus
A feature that allows you to view and concentrate only on the highest prioritized task that has not been 
completed from your prioritized Daily Task List.



Franklin Day Planner
A date-book-organizer to aid you in controlling daily events and schedules.    The Franklin Day Planner is 
designed to improve your personal productivity as well    as help those around you.    For additional 
information about the Franklin Day Planner call 1-800-654-1775.



Goto Calendar
The Goto Calendar has several uses.    The primary purpose is to forward or move Tasks to days in the 
future.    The Goto Calendar can also be used to view Special Days, Daily Tasks, and Appointment 
Schedules.



Icons
Small pictures representing one of Ascend's modules or other Windows programs.



Importing Records
A routine used to put address and phone information into Ascend from another computer file.



Master Task List
A file to temporarily store tasks that you would like to do someday but don't want to schedule    on a 
particular day yet.



Modem
A device that connects your computer with a phone line.    If you have a modem you will be able to use the 
auto dialer.



Page Date
The date that represents the date of a page in your Franklin Planner.    This is the date that is displayed 
between the    two arrows on may of Ascends windows such as the Daily Prioritized Task List, Daily , etc.



Point
Move the mouse until the pointer rests on the item you want.



Prioritize
A process to put your Daily Tasks in the sequence in which you want to complete them. 



Rank
Part of the process to prioritize your Daily Task List.    After your tasks are put into either A, B, C, or D    
priority, they are then given a numerical ranking.



Recurring Appointments
An appointment that can be scheduled at consistent intervals.



Recurring Task
A task that must be scheduled at consistent intervals.



Registration
Each Ascend program must be registered to the person or company who purchased the program.    Fill 
out your Ascend registration card and mail it to SIS.    After SIS receives your registration card, they will 
mail you a KEY NUMBER.    Your Ascend program will only work for 60 days before requiring your Key 
Number.



Repeat Task
A task that you want to re-schedule a certain number of days after the completion of the same task.    
Repeat Task are different from Recurring Task because they are re-scheduled based upon the completion 
date.



Restore
A routine that allows you to restore data from a floppy diskette to your Ascend sub-directory on your hard 
drive.



Search
Ascend's Search routine can be accessed from several of Ascend's modules(Appointment Schedule, 
Daily Record of Events,Journal, etc.) and is used to search through various parts of your planner's data 
for a specific word or words.



Speed Dial
A method to quickly dial a phone number from your address and phone module.    You must have a 
modem to Speed Dial.



Statistics
A routine accessed from the Daily Task List.      Move the cursor to one of your tasks, pull down the View 
Menu and select Statistics.    This will display a dialog box containing misc. statistics about tasks.



Systems Date
This is the date that your computer keeps as the "currrent" date.    This is also the date displayed in the 
Date Status Bar.



Task Code
A Task Code designates what action was taken on a task (completed, forwarded, delegated, etc.).    The 
Task Code column is the furthest to the left on the Prioritized Daily Task List and designated by a down 
arrow. 



Technical Support
Refer to on-line help and the User's Guide to find an answer to your questions or problems.    If you are 
unable to solve your problem, you can call Ascend's Technical Support Help Line.

Ascend's Technical Support: 801-476-9262
If your question is concerning Windows, you should call Microsoft's help line.

Microsoft's Technical Support: 206-454-2030



Time Blocks
A Time Block is a 15 minute block of time.    Time blocks are used in the Time Management routine as well 
as in the appointment schedule routine. 



Window
A "window" is an area on your computer's screen where a program (or part of a program) is running.    For 
example, you could have one window running your Ascend, another window running your word processor, 
and still another window running your spreadsheet.    Windows allows you to quickly "jump" between 
these applications by pressing one key.



Font



Daily Record of Events
The right side of your planner usually used for notes, ideas and journal entries.





 Change Between Days

There are several ways to change between Days.

* You can go back one day at a time by pressing the big arrow to the left side of the Page Date.

* You can go forward one day at a time by pressing the big arrow to the right side of the Page 
Date.

* You can use the Goto menu to go to yesterday, today, tomorrow, forward a day, back a day, 
forward a week, or back a week,

* You can use the Goto menu and the Date sub-menu to pop-up a calendar.    From the 
calendar you can double click on the date you desire to go to or you can enter the date in the 
entry box.

* You can press the F4 function key and the Goto Calendar will appear.    Use this calendar to 
change the page date as explained in the previous step.

* You can quickly have the Page Date "jump" to Today's Date by double clicking on the Date 
Status Bar (Located directly under the Menu Bar). 



Method 1 - Dialog Box

You have the following task codes to select the progress of a particular task.

Not Completed This code is a blank and symbolizes that the task still needs to be done.

Task Completed This code is a check mark and symbolizes that the task has been 
completed.

Planned Forward This code is a arrow pointing to the right.    This code symbolizes that the 
task has been forwarded to a future date.

Task Deleted This code is a large "X" and symbolizes that the task has been deleted.

Delegated Task This code is a square and symbolizes that the task has been delegated 
to another person.

In Process This code is a circle and symbolizes that the task is currently in progress 
but cannot be finished at this time.

Delegated and Completed

This code is a square with a check in it.    It symbolizes that the task was 
first delegated and then it was completed.

Process Completed This code is a circle with a check in it.    It symbolizes that a task that was 
in process has been completed.

You can select from these codes by Clickinc your mouse in the task code box next to the task you 
wish to mark.

Select the desired action by double clicking on one of the options.

If you select Planned Forward the monthly calendar will appear for you to select the date that you 
would like to forward the task to.

The Delegated & Completed option and the Process Completed options do not work unless a 
task was first given the Delegated or In Process designation.



Method 2 - Right Mouse Button

Pressing the right mouse button will "thumb through" the different task codes.    This is a very 
handy method to quickly mark tasks as having been completed.

Since the Planned Forward requires the Goto calendarto be displayed, you cannot select this 
option using this method.



Method 3 - Group Action

Group action allows you to quickly mark all of the tasks on a Page Date that have not been 
marked with a code with their appropriate code.

Most users will use this method each morning to "clear out" the previous day before planning the 
current day.

To access the Group Action method, pull down the Task Options Menu and then select Group 
Action.

From here you can select any one of the following options for each task:

Completed

Deleted

Forwarded

Completed and Copy

The next seven days of the week

After you are finished with Group Action, press the OK button.



Search For

Ascend's Search routine can be accessed from several of Ascend's modules (Daily Task 
List,Journal, Appointment Schedule, etc.), and is used to search through various parts of your 
planner's data for a specific word or words.

To access the Search dialog box, select the Search Menu option.

A dialog box will appear with the following options:

Search For Enter the text that you want to search for.

Task Check this box if you want to search through your tasks.

Task Notes Check this box if you want to search through your task notes.

Appointments Check this box if you want to search through your appointments.

Appointments Notes Check this box if you want to search through your appointment notes.

Daily Record of Events Check this box if you want to search through your daily 
record of events.

Journal Check this box if you want to search through your journal entries.

Phone & Address Check this box if you want to search through your Phone and Address 
notes.

Master Task List Check this box if you want to search through your Master Task List.

Master Task List Notes Check this box if you want to search through your Master Task 
List notes.

Starting Date Enter the starting date for the search.

Ending Date Enter the ending date for the search.

Press the Search For button to begin search.    Each match found will be displayed in the scroll 
list at the bottom.    You may then select the proper match and Ascend will jump to that day's 
entries.



Finding Names

To find a name in your Phone and Address list, simply start typing in the Last Name or Company 
Name of the record you are looking for.    You may also use the mouse to search through the 
scroll list to find the correct name.

Once you have found the correct name, press the OK button.


